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Removing trial restrictions
When you first start Movavi 360 Video Editor, it will be running in TRIAL MODE. To use the program without trial restrictions,  you will need to
buy the full version and activate Movavi 360 Video Editor.
 
Step 1: Buy an activation key. The key will be delivered within the hour to the e-mail you provided during checkout. If you already have a key,
skip to step 2.
 
Step 2: Open the Help menu and select Activate software.



 

 

Step 3: Enter your activation key and click Activate.

Activating without Internet access
If the computer you have installed Movavi 360 Video Editor on is not connected to the Internet, you can activate the program via e-mail.
See detailed instructions
 
I bought Movavi 360 Video Editor, but my videos already have a watermark
After you have activated the program, you can open the movie project and re-export the movie without the watermark.
How to export videos
 

Trial restrictions
When you first start your copy of Movavi 360 Video Editor, it will be running in LIMITED TRIAL MODE. In trial mode, you can try out all of the
main features, but the following trial restrictions will apply:
 
TRIAL VERSION FULL VERSION

 Movavi 360 Video Editor will stop working after 7 days  Lifetime license

 A watermark with the words ' trial version' will be added to all
exported videos.

 No annoying watermarks

 Audio files will only be saved halfway.  Free updates
   Discounts on other Movavi products and upgrades
 
To remove the restrictions, buy an activation key and use it to activate Movavi 360 Video Editor.

Activating without Internet access
If you do not have Internet access on your computer, you can use any other device to activate Movavi 360 Video Editor via e-mail.
 
Step 1: Buy an activation key. The key will be delivered within the hour to the e-mail you provided during checkout. If you already have a key,
skip to step 2.
 
Step 2: Open the Help menu and select Activate software.



 

 

Step 3: Enter your activation key and select the Activate offline option. Then, click Activate.

Step 4: In the next window, click Copy and transfer this information to a computer or device with an Internet connection.

Step 5: When you have access to the Internet, paste the information you copied into a new e-mail and send it to reg@movavi.com. You
should receive a reply within an hour. Copy the registration key from the reply and transfer it to the computer with Movavi Video Editor.

Step 6: Return to the window with offline activation. If you've closed the window, repeat steps 1-3 and enter the same activation key you
used before. Then, paste the registration key into the box and click Activate.

mailto:reg@movavi.com


 

 

Quick start guide
Convert 360° files
Connect the camera to your computer and copy the 360° files to your hard drive. Before you can edit the videos, you may need to convert
them using the software that came with your camera. Different cameras shoot 360° video in different formats, and the videos must first be
"stitched" to join the footage from all lenses into a single spherical video. If you aren't sure how to do this, check your camera's user manual.

Add 360° video to the Editor
On the Import tab of Movavi 360 Video Editor Click Add Media Files and choose the 360° videos you want to use in your project. They will
appear on the Timeline in the bottom part of the window. The order and length of files on the Timeline determines their appearance in the
finished video.

View 360° video
360° videos can be viewed in equirectangular and 360° modes. To switch between the viewing modes, click the 360° button under the player.

Equirectangular mode – the entire video frame is visible in the player, however, objects may appear distorted. This mode is useful for placing
titles and other objects on the video, where it is necessary to view the entire scene.

 



 

 

360° mode – the video appears in a natural 360° projection and you can only see a part of the video at once. To navigate the 360° scene,
click and drag your mouse over the player, or use the directional buttons in the upper left-hand corner of the player.

   
Equirectangular and 360° mode

 
Edit 360° video
Use the buttons on the toolbar to make quick adjustments to the videos and images. To cut a clip into two parts, place the position marker
where you want to make the cut and click the scissors button.
Learn more: Cutting clips | Color adjustments

 
Add filters
Next, why not add some creativity and apply a color filter or a cool effect to your video. To do that, click the Filters button on the left and pick
a filter you like. Then, drag the filter's icon onto the clip on the Timeline to apply it.
Learn more: Filters

Add transitions
You can join even 360° clips with animations to transition from one clip to another. Click the Transitions button on the left sidebar to open
the list of transitions. Pick a transition and drag its icon onto the Timeline, between the clips you want to join.
Learn more: Transitions



 

 

 
Add annotations
Click the Titles button on the left to open the list of text styles for your 360° video. Drag a style's thumbnail onto the uppermost track of the
Timeline above the clips you want to annotate. Text clips appear as purple ribbons on the titles track. To edit the text, double-click the titles
clip and type the text in the player. Use the toolbar at the top of the player to change the font, size, and color of the text.
Learn more: Titles

 
Add music and edit audio
Click Add Media Files on the Import tab to add music from audio files. Added audio clips will appear on the audio track of the Timeline. To
edit audio, select a clip and click the Audio Properties button on the toolbar. Here, you can edit volume, fade sound, and apply audio effects.
Learn more: Editing audio

 
Save and share
When you're finished with your 360° video, it's time to save it for playback or upload it to YouTube. Click the Export button in the bottom
right-hand corner to open the saving options. If you want to save just the video file, use the Save as video tab and choose a video format for
saving your 360° file. If you want to share the video on YouTube, switch to the Upload online tab, click Sign in at the top to authenticate with
YouTube, and enter the name, description, and other details for your YouTube video.
 
Then, choose a location for saving the video file (a video file will also be saved to your hard drive even if you're uploading to YouTube) and
click Start to begin processing the 360° video. Note that not all media players support viewing 360° video.
Learn more: Exporting videos | Uploading videos online



 

 

Projects
A Movavi 360 Video Editor project is a file in the *.mepx360 format that contains your work on creating a video. A project stores the locations
of each media file used in the project, as well as the edits, special effects, and settings that you use as you make your movie.
 
Creating a project
To create a new project, open the File menu and choose New Project. A new project will be automatically created when you start Movavi 360
Video Editor.
 
Saving projects
To avoid losing your editing progress, make sure to save your project every once in a while. To save a project, open the File menu and choose
Save Project.
 
How to change where projects are saved
1. Open the Settings menu and choose Preferences.
2. Click the Files tab.
3. Find the Save project files to box and click the button next to it to choose a different folder for storing your projects.
4. Select the folder you want to use and click Select Folder. 

 
Opening projects
To open a previous project, open the File menu and choose Open. Then, find the project file and continue working on your movie. By default,
your projects are saved to "\My Videos\Movavi 360 Video Editor\Projects".
 
A: Find your project in Windows Explorer and drag it onto the Video Editor window.
 
B: Find your project in Windows Explorer and double-click it to open it.
 
C: Click Open Project on the welcome screen. Then, locate the project file in the Windows Explorer box and click Open.
 
D: Open the File menu and choose Open Project. Then, locate the project file in the Windows Explorer box and click Open.
 
Media use
When you open a previously created project, you may see a message saying that a file is missing from the project. This may happen if one of
the files used in the project has been moved somewhere else or deleted from disk.  In this case, click Browse in the message box to find the
file in its new location, or click Skip to open the project without the missing file. We recommend that you copy all the files to your hard drive
before editing.
 
How can I play my project?



 

 

Project files cannot be viewed in a regular video player, but can only be opened with Movavi 360 Video Editor. To view the finished work in a
player, you need to first export your movie to a common video format.
Learn how to export your project
 
Restoring work from an autosave
If your computer malfunctions and you cannot save the project, some of your work may be restored using an autosave file. Simply rename
the "autosave.mepx360" file and open in in the Video Editor to continue working on your project.

 
Adding files

To begin working on your video project, you will first need to add some media files to the Editor.
  
Step 1: Copy files to your computer
Connect your camera to the computer with a data cable and transfer the files you want
to use onto your hard drive. This will let you achieve faster performance while editing
than working with files located on the camera storage, because accessing large 360°
files over a data cable may be very slow.

 
Step 2: Convert 360° files
Some cameras shoot video in a proprietary 360° video format that can only be opened
with its own software. Use the software that came with the camera to convert the 360° files into a standard video format. Consult the
camera's user manual if you're having problems. If the videos are already in a standard format, skip to the next step.

Step 3: Add your 360° videos
Open Movavi 360 Video Editor and click Add Media Files on the Import tab. Choose the files you want in the pop-up dialog box and click
Open. Or simply drag the files from Windows Explorer onto the bottom part of the window to add them to your project. You can add 360°
videos, regular videos, images, and audio files.

Step 4: Arrange files
Once you've added the files, they will appear on the Timeline at the bottom of the window. The Timeline allows you to arrange the clips in the
order you want. The clips' position relative to the time ruler at the top of the Timeline determines when it will appear in the finished video. To
reorder the clips, select the clips you want to move and then drag them to the new position on the Timeline.
Learn about using the Timeline



 

 

Moving a clip on the Timeline
 
 

Recording audio
After you've added some videos and photos to the Timeline, you can record audio from a microphone or any other recording device.
 
Step 1: Open audio recording options
On the toolbar, click the microphone button to open audio recording options.
* There must be at least one clip on the video track.

Step 2: Set up recording
1. In the Audio device box, choose the device you want to use.
 
To record from a microphone: choose your preferred microphone or webcam microphone. If you don't see the device in the list, try
reconnecting it to your computer.
 
To record audio from the computer: select Stereo Mix from the list. This will allow you to record any music, alerts, or other sounds
playing on your computer.
 
2. (Advanced) In the Audio quality box, choose the sample rate and number of channels that you need.
 
3. Set the volume level you want to use in your project.

4. On the Timeline, place the progress marker to where you want the recording to begin. You will be able to move the clip later.
 

Step 3: Record sound
1. When you're ready, click Start Recording. You will be given a three-second countdown.
 
2. The video will start playing simultaneously with the recording. This way, if you're recording a voice-over, you will be able to use the video as
a visual aid as you speak.
 
3. When you're done, click Stop Recording. The recorded audio clip will already be on the Timeline, as a linked audio clip.
* The recording will stop automatically if it reaches the end of the video track.



 

 

Using built-in media
Movavi 360 Video Editor comes with an extensive collection of built-in media that you can use in your projects for free.
 
Step 1: Open the Import tab
Click the Import button in the upper left-hand corner to open the media options.

Step 2: Choose a media type
On the left side of the Import tab, you can switch between using your own media files and adding clips from the stock collection.
 
•  Sounds – fun sound effects and audio samples to make your videos more expressive.
 
•  Music – instrumental tracks for your background music.
 
•  Sample video – video clips that you can use as intros, overlays, and animated backgrounds.
 
•  Backgrounds – image backdrops for your titles and transparent clips.

Step 3: Add the clip to your project
To use a stock clip in your project, pick a clip you like and drag it to the Timeline, onto the video track or the overlay track.



 

 

I can't use the stock media clips
The stock media clips are usually downloaded when you start Movavi 360 Video Editor for the first time. If you don't have an Internet
connection, the stock media will be unavailable, but the clips will be downloaded the next time you connect to the Internet. Once downloaded,
the clips will be stored in your "\My Videos\Movavi 360 Video Editor\Media Content" folder.

File information
Find the file's location
To find the location of the clip's original file, right-click on the clip on the Timeline and choose Show in Folder from the menu.

See a clip's media information
To see a clip's media properties, right-click it on the clip Timeline and choose File Information from the menu.

A small File Information window will appear. Here, you can find the resolution, aspect ratio, and other properties of the original file. Knowing
certain information about a clip will allow you to better understand which settings are best for your videos.

Using the Timeline
The Timeline, located in the bottom part of the window, is the working area that allows you to organize and edit the clips. The Timeline
consists of several tracks, which are all synchronized to a single time scale at the top, which indicates the time of the project. 
 
Timeline tracks
Your clips are arranged on tracks by media type:

•  Titles track – contains text clips.
•  Overlay track – contains videos and images that are shown on top of other clips.
•  Video track – contains videos, images and the transitions between them.



 

 

•  Linked audio track – contains audio clips that are synchronized with the video track.
•  Independent audio track – contains audio clips that are not linked with the video track, such as background music.

Learn more about timeline tracks
 
Arranging clips
By default, media files will appear on the Timeline in the same order in which you've added them. To rearrange the clips, drag them with your
mouse and drop them onto the desired position. To select multiple clips, use Ctrl+click or click and drag to draw a selection on the Timeline.

Zooming the Timeline
To change the zoom level of the Timeline, drag the Scale slider at the bottom of the window. Move the slider left to zoom out, and move the
slider right to zoom in on the Timeline.

Position marker
The position marker defines the currently selected point on the Timeline. There are two position markers: the orange line on the Timeline,
stretching down from the time scale all the way through all of the tracks, and the position marker on the progress bar of the player. Both
denote the current position relative to the whole project and show identical time.
 
The timestamp in the player displays the currently selected time from the beginning of the project.
Learn more about previewing clips

 
Timeline tracks

The Timeline is made up of several tracks, one for each media type, that allow you to arrange the clips in chronological order; mixing and
joining the clips together to create your unique video.
 
Video track
The video track contains video clips and their attached audio, images, and transitions between clips.
•  You can link audio and titles to video and image clips so that they will stay in sync as you edit the project.
•  You can rotate, adjust, and use other tools on video and image clips on this track.
•  You can apply filters to video and image clips on this track.

 



 

 

Linked audio track
The linked audio track contains audio clips that are linked to video clips. At the beginning of each linked clip, you can see a blue line that
connects it to the video or image clip it is linked to. When you move, split, or delete the clip on the video track, the linked audio clip will also
be edited with it. This is useful if you've synchronized the clip's audio to the video track and don't want it to change as you edit your project.
•  The linked audio track is hidden at first, until you drag an audio clip between the independent audio track and the video track.
•  You can edit the audio clips' volume and speed in the Tools tab.
•  You can have several audio clips playing simultaneously. To do that, simply place them one under the other.
 
Independent audio track
The separate audio track contains audio clips that are not dependent on clips on the video track. This track is good for background music.
•  You can edit the audio clips' volume and speed in the Tools tab.
•  You can have several audio clips playing simultaneously. To do that, simply place them one under the other. 
Learn more about audio tracks

  
Linked audio (left) and independent audio (right)

Titles track
The titles track contains text clips that will appear on top of all other clips.
•  You can change the titles' duration on the Tools tab, or by dragging the edge of the title's clip on the Timeline.
Learn how to place titles
 
Overlay track
The overlay track contains additional video and image clips to create special effects like Picture in Picture or Chroma Key.
•  Clips on the overlay track are linked to clips on the video track and will stay in sync as you edit the clips.
•  You can apply filters and use all of the Tools to edit the clips on this track, just like any other video or photo.
•  You cannot join clips on the overlay track with transitions.
Learn about using overlays
How to create a chroma key video
 
To select all clips on a single track, click the area with the track's icon to the very left of all clips.

Hiding and muting tracks
If you want to see how your project looks without some clips, you can disable separate clips or entire tracks.
 
Hiding clips
To hide a clip from view, right-click the clip and choose Hide Clip from the pop-up menu. The clip will not appear in the player or on the
finished video until you re-enable it.

Muting clips
To disable a clip's sound, right-click the clip you want to mute and select Mute Clip from the pop-up menu. The clip will not play in the player
or on the finished video.

Disabling tracks
To hide an entire track from view, click the eye icon  to the left of the track you want to hide. To disable the sound for an entire track, click
the speaker icon  to the left of the track.



 

 

 
Previewing clips

Use the player in the upper right-hand part of the window to preview your project.
 
Playing the video
1. Move the position marker to where you want to start playback.
2. Click Play or press the Space Bar key. 
3. Click the Pause button or press the Space Bar again to pause playback.

1 – player position marker
2 – current time
3 – previous frame
4 – play/pause
5 – next frame

6 – switch 360° video mode
7 – unpin player
8 – view in full screen mode
9 – player volume

 
Position marker
The position marker shows which part of your project is currently shown in the player. There are two position markers: one on the player's
progress bar, and another on the Timeline. Both of them move simultaneously and you can use whichever you like.

To move the position marker, do any of the following:
 
•  Click anywhere on the Timeline to move the position marker to that position.
 
•  Drag the position marker (either on the Timeline or in the player). For higher precision, try zooming in on the Timeline.
 
•  To move in 0.5 second increments, open the Playback menu and choose Skip Forward by 0.5 Seconds or Skip Backward by 0.5 Seconds.
 



 

 

•  To move precisely from frame to frame, use the Previous frame and Next frame buttons in the player. This will move the position marker
exactly one frame backward or forward.
 
360° viewing modes
360° videos can be viewed in equirectangular and 360° modes:
 
Equirectangular mode – the entire video frame is visible in the player, however, objects may appear distorted. This mode is useful for placing
titles and other objects on the video, where it is necessary to view the entire scene.

 
360° mode – the video appears in a natural 360° projection and you can only see a part of the video at once. To navigate the 360° scene,
click and drag your mouse over the player, or use the directional buttons in the upper left-hand corner of the player.

   
Equirectangular and 360° mode

To switch between the viewing modes, click the 360° button under the player.

 
Working with two monitors
If you have more than one monitor, you might want to detach the player into a separate window to have more room for editing. To do that,
click the Unpin player button under the player:

 
The player will then open in a separate window. When you want to return the player back into the main window, click the Pin player button in
the detached player or close the player window.

Undo actions
It's okay if you make a mistake or change your mind while editing videos because almost any action can be reversed!
 
•  Click the Undo button on the toolbar or press Ctrl+Z to cancel an action.
•  If you've cancelled an action but want to return to it, click the Redo button or press Ctrl+Z.

 



 

 

Cutting clips
Use the scissors button on the toolbar to cut video and audio clips into parts. To delete a clip you don't need, click the trash can button.
 
Splitting clips into parts
Step 1: Select the clip that you want to split.
Step 2: Move the position marker to the moment where you want to cut the clip.
Step 3: Click the Split button on the toolbar.

Cutting out fragments
Step 1: Cut the clip at the beginning of the unwanted fragment

1. Select the clip you want to cut.
2. Move the position marker to the beginning of the fragment. Use the Previous Frame and Next Frame buttons on the player to catch
the moment precisely.
3. Click the Split button. The clip will be cut into two parts, with the unwanted fragment at the beginning of the second clip.

 
Step 2: Cut the clip at the end of the fragment

1. Select the second clip the you've just cut off.
2. Move the position marker to the end of the fragment.
3. Click the Split button again. The fragment should now be in a separate clip.
 

Step 3: Delete the unwanted fragment
1. Select the clip with the unwanted fragment.
2. Click the trash can button or press the Delete key to remove this clip. The clip will be removed, and the remaining clips on the
Timeline will move to close the gap.

Trimming clips
If you only need to cut off some parts at the beginning or at the end of a video or audio clip:
Step 1: Place your mouse pointer over the edge of the clip.
Step 2: Click and drag the edge towards the center of the clip to trim the clip to the desired length.

For more precise navigation:
•  Open the Playback menu and use the Skip Forward by 0.5 Seconds or Skip Backward by 0.5 Seconds commands to jump half a second
forward or back.

using_the_timeline.htm#position_marker


 

 

•  Use the keyboard shortcuts to move the position marker half a second back and half a second forward, respectively: Shift+Ctrl+← and Shift
+Ctrl+←.
•  Use the Previous Frame and Next Frame buttons for precise frame-by-frame navigation. You can also use the Ctrl+← and Ctrl+← keyboard
shortcuts.

Filters
Using filters you can alter the mood of the video, make an old movie, overlay cool flying objects, and more.
 
Step 1: Open the Filters tab
Click the Filters button to open the filters collection. Click on a filter's thumbnail to see its preview in the player.

 
Step 2: Find a filter you like
•  On the left, you will see groups of filters. Click on a group to see the relevant filters.
•  If you're looking for a specific filter, enter its name into the search box under the group list.
•  If you really like a filter, click the heart icon to add it to the Favorites group. 

Step 3: Apply the filter
When you've found a filter you like, drag its thumbnail onto the clip you want to apply the filter to.

Once you've applied a filter, a star icon will appear on the clip, denoting applied filters and tools.



 

 

Clip with an applied filter
Removing filters
1. Click on the star  icon on the clip to see the list of applied filters and tools.
2. In the list, select the filter that you don't want.
3. Click Remove.

Transitions
Transitions are short animations that use geometric shapes and transparency to connect two clips in a creative way.
 
Add a transition
1. Click the Transitions button on the left sidebar to open the list of all transitions.

2. In the list of transitions, pick a style you like and drag-and-drop its icon between two clips on the Timeline.

A transition icon will appear between the two clips.

Change transition length
By default, each transition will be set at 2 seconds long. To change the transition length:
1. Double-click a transition on the Timeline to open transition properties.



 

 

2. In the Transition Properties window, enter the new transition length in the Duration field. The format is
hours:minutes:seconds:milliseconds. If you want all transitions that are currently in the project to have the same length, select the Set this
duration for all transitions option.
3. Click OK to apply the changes.

Add transitions to all clips
You can automatically add transitions between all clips in your movie in just a few steps:
1. Click the slideshow button on the toolbar. The Create Slideshow dialog box will open.
2. In the Create Slideshow dialog box, select a transition style that you want to use for all clips. If you want to use different transitions, use
the Random Transitions option in the list of transitions.
3. In the Transition duration box, enter the length that you want to set for all transitions. A transition cannot be longer than the shortest clip
in your project.
4. Click OK to accept the changes.
 

Remove a transition
To remove a transition from your movie or slideshow, right-click the transition on the Timeline and choose Remove Transition from the pop-
up menu. If you want to delete all the transitions in your project, choose Remove All Transitions.

Titles
Adding text titles to your movie allows you to express your thoughts and supplement the audio with subtitles.
 
Step 1: Go to the Titles tab
On the left-hand side of the window, click the Titles button to view the titles collection. Click on a title style's thumbnail to preview its looks in
the player and choose the titles you want to use.



 

 

Step 2: Add a title clip
To add titles to your project, pick a title style you like and drag its thumbnail onto the title track of the Timeline, right above the video track,
onto the time where you want them to appear. The title clip will appear as a purple ribbon on the Timeline.
 
The beginning of each title clip is linked to a corresponding video clip on the video track. This way, whenever you move or edit the video clip,
its titles will always stay in sync.

To make several text clips appear simultaneously, simply place them one on top of another on the titles track.
 
Step 3: Edit titles
When you've added a title clip, it will start out with the default text and looks. Double-click the title's ribbon on the Timeline to show editing
options in the player. When you edit titles, the player will always appear in equirectangular mode so that you can see the entire frame in the
player.
 
Title clip properties

Click the cogwheel icon  at the top of the editing panel to see title clip properties. Here, you can change the duration of the titles and
animation speed (how fast they will appear or disappear).
 
Editing text
1. In the preview, double-click on the text box you want to edit.
 
2. Enter the new text.

3. Click the Font properties  button and select the font style, size, and alignment options for the selected text.

4. Click the Color properties  button and choose a color for the text, and the outline's width and color.
 
5. Drag the text box to where you want to see it on the video.
 
Editing decoration elements
Some titles come with frames, ribbons, and other decorations. To change their color, select the decoration element you want to edit and click

the Color properties  button. Then, click the Decorations color palette and choose the new color.
 
Finally, click Apply to exit editing mode.



 

 

See also:
Adding a timer
Title track

Adding a timer
Step 1: Open the Titles tab
Click the Titles button on the left sidebar to open the list of title styles.

Step 2: Add Timer titles
1. Find the "Timer" title style. Use the search bar or click the Basic group to filter the styles.
2. Drag the Timer titles onto the title track of the Timeline. Move the clip along the Timeline until its beginning is where the titles should
appear. To change the length of the timer, drag at the edges of the clip.

Step 3: Edit the timer
1. Double-click the timer clip on the Timeline to edit it. A properties panel will appear over the player.

2. On the Clip properties tab , set the duration and the format of the timer. The format determines which units of time are visible on the
timer: hours (hh), minutes (mm), seconds (ss), and milliseconds (zzz).



 

 

3. On the Font properties tab , choose the font and style of the numbers.

4. On the Color properties tab , set the color of the numbers and the background color. To make the background transparent, click the
background color square and set Opacity to 0%.

5. On the Timer tab , enter the starting time into the From box. If you want the timer to count backwards, select the Countdown option.
 
6. In the player, drag the Timer to the necessary location on screen.
 
7. Finally, click Apply to exit editing mode.

 
Title track

Titles appear on the Title track at the very top of the Timeline as purple ribbons. You can also place title clips on the main video track, if you
want them to appear on a black background. To show several text clips simultaneously, simply place them one on top of another on the title
track.

A clip's length and position relative to the Timeline ruler shows when the titles will appear on the video.
 
Time
To change when the titles appear, drag them along the Timeline and place the beginning of the ribbon at the time when the titles should
appear.
 
Length
To change the duration of the titles, hold your mouse pointer over the left or right edge of the clip and drag it to change the length.
 
Title synchronization
Every title and callout clip is linked to a clip on the main video track. A purple line connects the title or callout clip and the video clip. This
allows you to freely edit your videos without losing sync with the titles.
•  When you move the main video clip, any connected titles or callouts will be moved with it.
•  If you delete the main video clip, any connected titles or callouts will be deleted with it.
•  If you split the main video clip, any connected titles or callouts will also be split in the same position.
•  To link the titles or callouts to a different clip, drag the purple ribbon on the timeline over the clip you want to link it with.
 
Overlapping titles and callouts
You can play several titles and callouts simultaneously by overlapping them on the title track. Simply move one clip under another and they
will both show on screen at the designated time. On screen, the clips will be layered in the same order as they are on the Timeline.



 

 

The exclamation mark icon covers a part of the text bubble because its clip is at the top of the Timeline.
 
 
 
 
 

Highlight and conceal
Using the Highlight and Conceal tool, you can mask your 360° camera's blind spots or stitching points, as well as bring attention to objects
on screen or hide sensitive information.
 

Step 1: Open the Highlight and Conceal tool
1. On the Timeline, select the clip that you want to edit.
2. On the left sidebar, click the Highlight and Conceal button. The tool's options will open, and a frame will appear in the player. While editing
masks, the player will appear in equirectangular mode so that you can see the entire frame.

Step 2: Set up the mask
1. In the Highlight and Conceal tool, open the box and choose Conceal if you want to hide something, and Highlight if you want to bring
attention to it.

2. Choose a shape for the mask: you can use a rectangle or an ellipse.
 
3. Choose a masking effect: blur, matte (black cover-up) or pixels. Use the options below to fine-tune the mask:
•  Opacity – makes the mask more transparent (for matte and blur)
•  Feathering – makes the edges of the mask softer (for matte and blur)
•  Size – changes the size of the pixels (for pixel masks only)
•  Outline – adds a white outline around the mask.



 

 

4. In the player, drag the corners of the mask to change its size and shape, and drag by the center of the mask to move it on top of the object.

Step 3: Add more masks (optional)
If you want to cover up or highlight more than one object, click Add Mask above the player to create another mask, and you can now set it up
the same way as the first. The selected mask is highlighted orange in the player.

Step 4: Apply the changes
When you're done, click Apply on the Highlight and Conceal panel to finalize the changes.

Chroma key
How to replace a video's background

The Chroma key effect allows you to remove any color from the image or video, leaving the background transparent.
 
Step 1: Add the foreground and background clips
Add the video or image clips that you want to use as the foreground and the background. For the foreground (the clip that you want to
remove the background from), use a clip with a bright, solid background that contrasts with the foreground objects. For best results, the
overlay video should also be a 360° format video so that it is not distorted.
 



 

 

Step 2: Create an overlay
1. Select the foreground video and move it up, onto the Overlay track.
2. Double-click the foreground video on the Overlay track. The overlay options will appear above the player.
3. To make the foreground video completely cover the background video, select the Cover overlay mode from the list above the player. If the
overlay footage is not a 360° video, use Picture in picture mode and make it smaller to avoid distortion.
4. Click Apply.

Step 3: Open the Chroma Key tool
1. Select the foreground video on the Overlay track.
2. On the left sidebar, click the Chroma Key button. The Chroma Key options will appear.
Tip: If you don't see the Chroma Key button, click the More button and select Chroma Key in the pop-up list.

Step 4: Set up Chroma Key
1. Once you open the Chroma Key tool, move your mouse cursor over the player and click on the color that you want to remove. The color
you've picked will be made transparent, and the underlying video will now be visible.
Tip: if nothing happens when you click on the player, click the color swatch in the Chroma Key options and then try again.

2. Use the Tolerance slider to set how many similar shades of the selected color should also be removed. Higher values will remove similar
colors to the one you've selected.
3. Use the Noise slider to determine how sharp the object's edges should be.
4. Use the Edges slider to determine how thick the object's edges should be.
5. Use the Opacity slider to set the transparency of the background.
6. Finally, click Apply to accept the changes.



 

 

Editing video and images
After you've added some videos and images to your project, they will appear on the video track of the Timeline, where you can move and
arrange them into a movie. Next, it's time to edit and enhance the clips.
 
Cut video clips
On the Timeline, select the clip that you want to cut and move the position marker onto the moment where you want to split the clip. Then,
click the scissors button on the toolbar to split the clip into two parts.

Edit 360° videos and images
Photos and videos aren't always perfect from the beginning. Use the buttons on the toolbar to fix and adjust the clips.
 

Learn more: Color adjustments | Volume | Speed | Image duration | Fades | Video properties

Picture in picture and overlays
To overlay one video or image on top of another, select the clip you want to show on top and drag it up, towards the top of the Timeline to
create an extra overlay track. Then, double-click the upper clip to set up where the overlay will be shown on the video.
Learn more about overlays

Picture and picture, side by side overlay modes.
 
Creating freeze frames
A freeze frame is a still shot inserted in the middle of a video for dramatic effect. You can use the freeze frame to emphasize a very fast
movement or pause the action while you give additional information.
Learn more about freeze frames



 

 

Before and after adding a freeze frame
Video tracks

When you add videos or photos to your project, they are added to the video track of the Timeline. From there, you can rearrange the clips and
move them to other tracks.

Video track
The video track contains your videos with their built-in audio, photos and the transitions between them. To arrange clips on the video track,
simply drag them with your mouse.
 
•  You can link audio and titles to video and image clips so that they will stay in sync as you edit the project.
•  You can rotate, adjust, and use other tools on video and image clips on this track.
•  You can apply filters to video and image clips on this track.
•  You can also add titles to the video track, if you want to show them against a solid black background.
 
Overlay track
The overlay track is used to show a photo or video on top of the main video track. You can use overlays to show split screen footage or
create a chroma key effect.
 
To create an overlay, select a clip on the video track and drag it up, onto the overlay track. By default, new overlays are created in picture and
picture mode. To change the overlay mode, double-click the overlay clip and choose a mode in the control panel on top of the player.

Overlay modes: picture in picture, side by side, cover
 
 
•  You can add filters and any special effects to the overlay track.
•  You cannot use transitions on the overlay track.
•  Every overlay clip is linked to the corresponding clip on the video track.
Learn more about overlays
 
Linked clips
Clips on the titles, linked audio, and overlay tracks are all linked to a clip on the video track. You will see a line joining the beginning of the
linked track to a corresponding position on the video track. Whenever you move a clip on the video track, any clips linked to it will also move
with it. This allows you to keep clips synchronized as you edit the video.

Linked overlay, titles, and audio tracks
Color adjustments



 

 

If the original videos look bleak and not vibrant enough, you can use the automatic adjustments to make the colors look more vivid. If that
isn't enough, you can always use manual adjustments to correct the colors.
 
Step 1: Select clip
On the Timeline, select the clip that you want to adjust.
 
Step 2: Open color adjustments
On the toolbar, click the color adjustments button to open the adjustments tool.

Step 3: Use auto adjustments
Select the adjustment options that make the selected clip look nicer. The changes will be applied instantly. The Magic Enhance option will
automatically determine the best brightness and contrast balance.

Step 4: (Optional) Use manual adjustments
Click the Manual Adjustments button to show more color control options. Here, drag the sliders to fix the brightness, saturation, hue, and
other properties. To go back to the simple options, click the Auto Adjustments button underneath the sliders.

Once you have used the adjustments, the clip will be marked with a star icon, denoting applied tools or filters: 

Video volume
This section explains how to manage the volume of video clips. To change the volume of audio clips, refer to the Volume levels section.
 
Step 1: On the Timeline, select the video that you want to edit.
 
Step 2: Click the Clip Properties button to open the video properties for the selected clip.



 

 

Step 3: Drag the Volume slider to set the volume for the selected clips.100% is the original volume.

•  To mute the clip, click the volume icon to the right: .
 
•  If the clip has a lot of volume peaks, try the Normalize option to raise the volume of quiet parts.

Video speed
With the Speed tool, you can speed up or slow down a video or audio clip. This can be useful if you're working on a music video and you want
the video to match the tempo of the music.
 
Step 1: On the Timeline, select the clip you want to edit.
•  Note that slowing down videos works best on videos with a frame rate of 60 FPS (frames per second) and above.
•  You can also change the speed of any audio clip.
•  If you modify the speed of a video with built-in audio, the audio speed will also be changed.
 
Step 2: Click the Clip Properties button to open the editing tools for the selected clip.

Step 3: Drag the Speed slider to set the necessary video speed, where 100% is the video's original speed.



 

 

The clip's length on the Timeline will change to reflect the new speed. If you've changed video speed, the video clips will be marked with a
star icon:

Changing image duration
By default, all images will be shown for 4 seconds each. To change the duration:

 
Step 1: On the Timeline, select the image clip that you want to edit.
 
Step 2: Click the Clip Properties button to open the properties for the selected clip.

Step 3: In the Duration box, enter the new length of the image. Use the following format: hours: minutes:seconds.milliseconds. Changes will
be applied instantly.

You can also change image duration by selecting an image clip on the Timeline and dragging its borders left or right. The longer the clip
appears on the Timeline, the longer it will play in your movie or slideshow.

 
 



 

 

Fading video
In the editing tools, you can add smooth fades to the beginning or the end of a clip. For videos and images, you can use fading
simultaneously with animated transitions. For audio clips, you can create a smooth crossfade effect between songs.
 
Step 1: On the Timeline, select the clip that you want to fade.
 
Step 2: Click the Clip Properties button on the toolbar. The clip properties will open in the Tools panel above.

Step 3: Set the fade length using the sliders on the Video tab.
 
Fade in – how long in seconds it will take to fade in to full opacity at the beginning of the clip.
 
Fade out – how long in seconds it will take to fade out from full opacity at the end of the clip.

See also:
Adding transitions
Fading audio
 

Video properties
To open the clip properties for a video or image, select the clip on the Timeline and click the Clip Properties button on the toolbar.

The Tools panel will open on the Video tab, where you can edit the following:
 
Volume — Sets the volume of the clip's built-in audio.
Only for video clips with built-in audio.
 
Normalize — Makes the quiet parts of the built-in audio louder.
Only for video clips with built-in audio.



 

 

 
Speed — Makes the video play faster or slower.
Only for video clips.
 
Opacity — Affects the visibility of videos and images on the overlay track. Reduce the clip's opacity to make it more transparent.
Only for clips on the overlay track.
 
Duration — Sets the precise length of the image clip.
Only for images.
 
Fade in — The video fades in from black in the time you set. Any built-in audio will also fade in.
For any clips.
 
Fade out — The video fades out to black in the time you set. Any built-in audio will also fade out.
For any clips.

See also:
Audio properties
Video volume
Video speed
Changing image duration
Fading video

Adding overlays
Overlays are video or image clips that are shown over the main video. You can use these to create a split screen or picture in picture effect,
add a logo or watermark, or insert a short clip without cutting the main video. Also, you can use overlays with the Chroma key tool.
 
Before you start:
You'll need to add both the main video (the video that will be the bottom layer) and the overlay video or image to your project.  You can use
images in PNG format to add transparent logos. Note that if the overlay video or image is not originally in 360° format, it may be distorted.
 
Step 1: Place the overlay clip
1. Select the clip that you want to make an overlay and drag it up, towards the top of the Timeline.
2. Drop the clip onto the overlay track, where you want it to be shown relative to the main video track.
Note that a blue line now connects the overlay clip to the main clip. This means that the overlay clip is linked to the main clip: if you move,
cut, or delete the main clip, the overlay clip will also be edited.

Step 2: Edit the overlay
1. Double-click the overlay clip to set it up. An options panel will appear in the player.
2. Open the drop-down box on the overlay panel and choose how you want it to appear on the video: Picture in picture, Side by side, or
Cover.

Picture in picture
This is the default overlay mode. Using picture in picture mode, you can show the overlay video over any part of the screen.
1. Choose Picture in picture mode from the drop-down box.
2. In the player, move the overlay to where you want it to appear in the frame.
3. To resize the overlay, drag at its corners.



 

 

4. Deselecting the Constrain proportions option will allow you to resize the overlay to any proportions, but a drastic change in proportions
may make the overlay look distorted.

Picture in picture overlay
 
Side by side
1. Choose Side by side mode from the drop-down box.
2. Use the buttons on the panel to choose how you want to align the two videos: 

Side by side overlay
Cover
Cover mode can be used for a short insert into the main video without having to cut it. While the main video (and audio!) is playing, the
overlay clip will appear on screen for the duration of the overlay clip.
 
If you want to replace a video's background using the Chroma key effect, use Cover mode to place the foreground on top of the new
background. Learn how to use Chroma key. 

Cover overlay: left - the main clip is hidden; right - Cover with the Chroma Key effect
 
Step 3: Apply the changes
After you've set up the overlay, click the Apply button on the overlay options panel above the player.
 
Step 4: Overlay clip properties
In the Tools panel on the left, set up the overlay's properties:

Volume: if you have several video clips playing simultaneously, you might want to mute one of the clips. To do that, click the mute  button,
or use the slider to lower the volume.
 
Opacity: if you want to make the overlay more transparent, lower its opacity, and the main video track will be seen through it.
 
Fade in / Fade out: while you can't use transitions on the overlay track, you can fade in the clip to make it appear smoothly. Set the slider to
the time it should take for the clip to appear.

See also:
Replacing video background with Chroma key



 

 

Using the Timeline
Creating a freeze frame

A freeze frame is a single frame of a video that repeats for some time, creating an illusion of pausing the video. You can use freeze frames to
emphasize a moment or create a pause to explain things to the viewer.
 
Step 1: Choose a frame
Move the position marker over the frame of the video that you want to freeze. To skip by precisely one frame at a time, use the Previous
frame and Next frame buttons under the player.

Step 2: Create freeze frame
Once you're on the right frame, open the Edit menu or right-click on the clip and choose Insert Freeze Frame from the menu.

Step 3: Set duration
By default, a new freeze frame is four seconds long. To change the duration, drag the edges of the clip to make the clip shorter or longer.
Learn about changing image duration

Adding a watermark
Adding a watermark to your videos will protect your ownership even if it's shared all over the Internet. You can add an image overlay with
your own watermark or logo, or make a new one using text.
 
Image watermark
Step 1: On the Import tab, click Add Media Files and add the image or video that you want to use as the watermark. For the best look, use
images with transparent areas.
 
Step 2: Drag the watermark clip up to the overlay track to make it appear on top of other videos.

Step 3: Double-click the watermark clip to edit the overlay. Move and resize the overlay in the player and then click Apply when you're done.
 
Step 4: To change the opacity, click the Clip Properties button and use the Opacity slider.
 



 

 

Step 5: To make the watermark show over the whole length of the video, enter your project length into the Duration box, or drag the right
edge of the overlay clip until the end of the video track.

Text watermark
Step 1: Click the Titles button on the left and pick a nice title style for your watermark.
 
Step 2: Drag the titles you like onto the beginning of the Titles track at the top of the Timeline.

Step 3: Double-click the titles and enter your watermark text. Pick a cool font and color on the panel above the player. Click Apply when
you're done.
 
Step 4: To make the watermark show over the whole length of the video, drag the right edge of the text clip until the end of the video track.
HINT: If your movie is long, zoom out on the Timeline to make changing clip length easier.
OR: Double-click the text clip to enter text editing mode and enter the length into the Duration field. You can find the length of your whole
project at the bottom of the window.

Fading effects
Making effects and filters fade in smoothly is possible using the overlay track.
 
Step 1: Copy the clip and paste it onto the Timeline.
 
Step 2: Drag the copy of the clip onto the overlay track above so that it's right above the original. Now you have two identical clips right on
top of each other.



 

 

Step 3: Double-click the clip on the overlay track and choose Cover mode in the panel above the player. Click Apply and the clip will cover
the entire frame.

Step 4: Now, apply the effects or filters you want to use onto the upper, visible clip.
Learn more: Applying filters

Step 5: With the overlay clip selected, click the Clip Properties button. There, use the Fade in and Fade out sliders to set the fading time.
Here you can also set Opacity if you want to reduce the effect's strength for the whole clip.

The clip with the effect will gradually appear and disappear, exposing the underlying original clip.
 



 

 

Editing audio
Add audio
To add music or other sounds to your project, click the Add Media Files button on the Import tab.

Learn more about adding audio:
Adding audio files | Recording audio | Extracting audio from video | Using built-in sounds

Audio tracks
When you add audio clips to your project, they will appear on one of the audio tracks at the bottom of the Timeline. There are two types of
audio track:
 
Linked audio track – each clip on this track is linked to a video clip on the main video track. This means that this clip will always stay
synchronized with this video.
 
Independent audio track – this is the standard video track, where audio clips such as background music will play independently from any
other tracks.
 
After you add the clips, you can rearrange them with your mouse and cut them just like video clips.

Learn more:
Audio tracks | Cutting audio | Looping audio

Volume
To change a clip's volume, click the Audio Properties button on the toolbar and set the necessary volume in the audio tools section above.

Learn more:
Volume levels | Volume curves | Muting clips

 



 

 

Audio properties and adjustments
To enhance and adjust the audio, click the Audio Properties button on the toolbar and scroll down in the audio tools section above.

Learn more:
Audio properties | Fading audio | Equalizer | Noise removal | Audio effects | Beat detection

Audio tracks
Audio in your project can be located on the video track as built-in audio, the linked audio track, or on the independent audio track. When you
add audio files to your project, they are first placed onto the independent audio track.

 Independent audio track
All new audio clips are added to the independent audio track. Audio clips on this track will play independently of any other tracks and will not
change when you edit other clips. This makes it suitable for background music.
 
 

 Linked audio track
Clips on the linked audio track are always linked to a clip on the main video track. This ensures that the clips stay in sync with the video even
as you edit your project and move or cut the clips. At first, this track is hidden until you link your first audio clip.
 
To link an audio clip:
1. Select the clip you want to link.
2. Drag it up, towards the video track. The linked audio clip will appear between the video and independent audio tracks.
3. A line will appear between the video and the audio clips. Place the audio clip on the linked audio track so that the line points to where it
should begin.

Now, the audio is linked with the video clip that it points to. If you cut or delete the video clip, its linked audio clips (as well as titles and
overlay clips) will also be cut or deleted.

 



 

 

 Built-in audio on the video track
If a video clip has sound, both the video and audio will be added to the video track. The built-in audio is always together with its video, unless
you decide to move or delete the audio.
 
•  To separate built-in audio from its video clip, click on just the audio ribbon under the video clip, and then drag this ribbon down onto an
audio track. You can still keep the audio synchronized with the video by placing it on the linked audio track.

• 
 
To remove built-in audio, click on the audio ribbon under the video clip and click the trash icon .

 
Waveforms
Each audio clip's sound is represented as a waveform on the clip's ribbon. Waveforms can help you easily find the quietest and loudest parts
of the clip.

Playing audio synchronously
If you want two audio clips to play at the same time, simply drag one clip underneath the other. This way, you can have as many sub-tracks
as you want. With music, you can use this to create a crossfade effect when you join songs: align the beginning of the second song with the
end of the first song to make them joined almost seamlessly.

The end of the first audio clip will be played with the beginning of the second clip.
Problem: My audio clip appears on the video track
Solution: Some audio files contain album art, which may sometimes be recognized as the video stream. Therefore, these files may be placed
on the video track. In that case, drag the audio clip down onto the audio track, and delete the album art from the video track if you do not
need it.

Adding audio
You can add audio files in much the same way as you add photos and video files.
 
Add files from your hard drive
1. On the Import tab, click Add Media Files to browse for audio files on your computer.
2. A Windows Explorer dialog box will open. Choose the files that you want to use.
3. Click Open. The files will be added onto the audio track of the Timeline.

Use sample audio clips
If you don't have any suitable audio files, you can use free music tracks and sounds from the Movavi 360 Video Editor audio collection.
1. On the Import tab, click Music if you need a background music track, or click Sounds if you need short audio samples. 
2. Click on a clip to play it. When you've picked a clip, drag it onto the audio track of the Timeline.
Learn more about sounds



 

 

Record audio
1. Connect a microphone to your computer.
2. On the Timeline, place the position marker to where you want the recording to start.
3. Click the microphone button on the toolbar to open recording options.
4. Set up your recording device and volume.
5. Click Start Recording and record the audio. When you're finished, click Stop Recording. You'll find your new recording on the Timeline.
Learn more about audio recording

Set start time for audio clips
After you've added the audio files, they will appear on the audio track of the Timeline as blue ribbons. To change when the audio clip starts
playing, drag it along the Timeline, using the ruler at the top for time reference. 
Learn about audio tracks

Extracting audio from videos
If you want to use a soundtrack from a music video, you can extract it from a video file and use it in your project. 
 
Step 1: Open video file
On the Import tab, click Add Media Files and choose the video that contains the music you want. The file will be added to the video track of
the Timeline.



 

 

Step 2: Trim video
If you don't need the whole video's soundtrack, you can trim away the parts of the video you won't need. It's easier to do this with the video
file, as the video can help you visually find the beginning and end of the fragment you need.
1. Select the video you want to trim.
2. Move the position marker to the beginning of the fragment you want to keep and click the Split button on the toolbar (scissors). You've just
cut off the beginning of the video. 
3. Now, select the second clip and move the position marker to the end of the fragment you need. Click the Split button again, and the
fragment will now be in a separate clip.
4. If you don't need the other fragments, select them on the Timeline and click the trash can button on the toolbar to delete them.

Step 3: Extract the audio
The audio that belongs to a video is shown right underneath it on the video track. To separate it from the video, drag the audio stripe down
onto the audio track. If you don't need the video clip anymore, go ahead and delete it.

You can now work with the extracted audio clip separately.
 
Step 4: Save the audio (optional)
If you want to save the audio clip for later use, you can export it as an audio file:
1. Click the Export button. The export window will open.
2. In the Export window, switch to the Save Only Audio tab.
3. Select an audio format that you want to save the audio file in.
4. The Save to field shows where on the disk the file will be saved. To change that folder, click Browse and select a new folder.
5. Finally, click Start to save the audio file.
Learn more about saving audio
 

Please respect copyright laws and stay within the boundaries of fair use of copyrighted materials.
Using sounds

You can make your movies more expressive using the built-in sound samples.
 
Step 1: Click the Import button to open the Import tab.
 



 

 

Step 2: On the left part of the Import tab, click Sounds to open the sound collection.

Step 3: Click on a sound to play it and pick a sound you like. Drag the sound onto the audio track of the Timeline.

Step 4: (optional) To synchronize the sound with a video clip:
1. Select the sound on the Timeline and drag it up towards the video track.
2. The linked audio track will appear, and a blue line will connect the sound clip to the video track.
3. Adjust the position of the sound clip on the linked audio track so that the line points to where the sound should begin.

Volume levels
Changing volume levels works the same way for video and audio clips:
 
Step 1: On the Timeline, select the clip that you want to edit. This can be a video or an audio clip on any track.
 
Step 2: Click the Audio Properties button to open the tools for the selected clip.
 
Step 3: Drag the Volume slider to set the necessary level, where 100% is the original volume.

•  To mute the clip, click the Mute  button on the right.
•  If parts of the audio clip are too quiet, select the Normalize option to increase their volume.



 

 

Playback volume
Only for previewing
If you need to temporarily change the volume of playback in the editor, without changing the project's volume, click the speaker icon in the
preview area and set the necessary volume level. Please note that this will only affect the volume while previewing the project in Movavi 360
Video Editor, and will not affect the output file.

Volume curves
If you need more advanced volume control, you can use volume curves on the Timeline to set the volume for precise parts of any audio clip.
Learn more about volume curves

Audio clip with a volume curve
Volume curves

With volume curves, you can control the volume for each part of the clip and smoothly increase or decrease the volume.

Each clip has its own volume curve that starts out at 100% volume for the entire clip, and two points at its beginning and at the end. The
white line on the image below is the volume curve before you add any points.

Step 1: Set the base level
Drag the white line up or down to the necessary level. The top of the clip is 100% volume and the middle of the clip is 50%.

Step 2: Add a volume point
Points on the audio curve represent the volume peaks and lows. To add a point, right-click on the audio curve and choose Add Volume Point
from the pop-up menu. Next, drag the audio point to the necessary volume level. You'll notice that the surrounding parts also move with the
point to make the transition smoother.
 
Make as many points as you need for each part of the clip where you'd like a peak or a drop in volume.

Step 3: Manage the volume for a part of the clip
To set the volume level for a part of the clip, you'll need at least two points. Create a point at the beginning and at the end of the fragment:

Click and drag the white line between two points to change the volume level for this fragment. 
 
Step 4: Transitions
When you drag a volume point or a fragment, the parts of the curve to the left and right will also move with it.



 

 

However, this affects only the closest parts of the curve. To get more control over the behavior of the curve, create more volume points. This
way, only the adjacent parts will be adjusted, leaving the rest of the curve as it was.

 
Audio properties

To open the properties for any audio, including built-in audio on the video track, select the clip on the Timeline and click the Audio Properties
button on the toolbar.

The Tools panel will open on the Audio tab, where you can edit the following:
 
Volume — Sets the volume of the clip.
 
Normalize — Makes the quiet parts louder.
 
Speed — Makes the audio play faster or slower.
Changing the speed of built-in audio will also affect its video.
 
Fade in — The audio fades in from complete silence to full volume in the time you set.
Fading built-in audio will also fade the video.
 
Fade out — The audio fades out from full volume to complete silence in the time you set.
Fading built-in audio will also fade the video.

See also:
Video properties
Equalizer
Volume curves

Fading audio
In the editing tools, you can add smooth fades to the beginning or the end of a clip and create a crossfade effect between songs.
 
Step 1: On the Timeline, select the clip that you want to fade.
 
Step 2: Click the Audio Properties button on the toolbar. The clip properties will open in the Tools panel above.

Step 3: Set the fade length using the sliders on the Audio tab.
 
Fade in – how long in seconds it will take to fade in from silence to full volume at the beginning of the clip.
 
Fade out – how long in seconds it will take to fade out from full volume to silence at the end of the clip.



 

 

Equalizer
Using the equalizer, you can boost or reduce the levels of specific frequencies.
 
Step 1: Select the audio clip that you want to edit. This can also be a built-in audio clip on the video track.
 
Step 2: Click the Audio Properties button on the toolbar to open the audio tools. There, scroll down in the audio tools and click Equalizer.

Step 3: Choose an equalizer preset (optional)

Step 4: Drag the volume bars to adjust the frequencies to the necessary level.

0
Noise removal

Step 1: Select the audio clip that you want to edit. This can also be a built-in audio clip on the video track.
 



 

 

Step 2: Click the Audio Properties button on the toolbar to open the audio tools. There, scroll down in the audio tools and click Noise
Removal.

Step 3: Use the Noise suppression slider to set the amount of noise you want to remove.
•  Start with low levels and listen to the audio to check if the noise is gone.
•  Don't set the noise suppression too high if there isn't much noise because it can start muting other sounds.

 
Audio effects

Audio effects can transform the sound of an audio clip.
 
Step 1: Select the audio clip that you want to edit. This can also be a built-in audio clip on the video track.
 
Step 2: Click the Audio Properties button on the toolbar to open the audio tools. There, scroll down in the audio tools and click Audio
Effects.

Step 3: Click the box in the Audio Effects section and choose an audio effect you like.



 

 

Removing effects
When you've applied an audio effect to a clip, a star icon will appear on it:

Click on the star to show a list of applied effects. Then, select the effect you don't want and click Remove.

See also:
Using sounds
Audio properties

Beat detection
To make your movie or slideshow more dynamic, use the Beat Detection audio tool to automatically mark audio beats on the Timeline and
then adjust your movie to the beat of the music.
 
Step 1: On the Timeline, select the music that you want to detect beats for.
 
Step 2:  Click the Audio Properties button to open the audio tools. Then, scroll down and click Beat Detection.

Step 3: In the Beat Detection tool, click Detect Beats. The program will analyze the music and place beat markers on the Timeline.

Step 4: (optional) After the beat markers have been placed, you can modify their tempo. Use the Min time between beat markers slider to
make the beat slower or faster.



 

 

Step 5: Adjust your clips to the beat. When you trim or drag clips, they will now snap to the beat markers, making it easy to keep to the beat.
 
Removing beat markers
•  To remove beat markers for a specific audio clip, right-click the clip on the Timeline and select Remove Beats from the pop-up menu.
 
•  To remove all beat markers from your project, right-click the Timeline ruler and select Remove All Beats from the pop-up menu.

Looping audio
If the music file you've selected doesn't go all the way until the end of your movie, you can loop the audio and have the file play over again
until the end of the video.
 
Step 1:  Copy the audio clip. To do that, right-click the audio clip on the Timeline, and choose Copy from the pop-up menu, or use the Ctrl+C
keys.
 
Step 2:  Paste the audio clip onto the Timeline right next to the first clip. The clip will be inserted right after the position marker. Repeat until
the audio length is greater or equal to the video length.
 
Step 3: Now, the audio track may be longer than the video track. To trim the audio, hold your mouse pointer over the right edge of the clip,
and drag the edge to the left, until the end of the audio clip is right under the end of the video clip.

 
Exporting videos

When you're done with your project, you'll need to export it as a 360° video file. You can save your project as a video, export just the audio
track, or save the video file and upload it to YouTube right away. If you intend to play the video on your computer or mobile device, please
note that not all media players support 360° video playback.
Uploading to YouTube
Saving only audio
 
Step 1: Open the Export window
To start saving the video, click the Export button in the bottom right-hand corner of the Editor. The export settings window will open.

Step 2: Choose a format



 

 

Open the list at the top of the window and choose a format and video codec for saving the video. MKV and MP4 are both widespread formats
that can contain the data required for 360° playback.

Step 3: Check your project settings
By default, the video will be exported with the same settings that were set for the project. This way, the output video will appear exactly as

you've seen it in the preview area. If you want to change the resolution, aspect ratio, or other settings, click the pencil icon  to view and edit
the project settings. For best results, select the resolution that is closest to your original videos.
 
The Estimated File Size field shows how much disc space your file will require after saving. Note that 360° videos are very large and may
need extra free space.
Learn more about project settings

Step 4: Select quality (optional)
If your project is heavy on small details and filters, you can select High or Highest quality to export the finished video with a higher bitrate.
This will significantly increase the output file size but will preserve better quality. For most other projects, Good quality will provide a nice
result at a small file size.

Step 5: Choose a destination folder
Name your file and choose a destination folder.
In the 'Save to' field, enter the folder where you would like to store the file. By default, this will be the directory for saving output videos
specified in the preferences. To set a different folder, click the Browse button and choose the folder in the Windows Explorer window, or
enter the path manually into the box. Name your video in the File Name field: the project's name will be filled in for you by default.



 

 

Step 6: Start exporting
Click the Start button to begin processing the video file. This may take up to a few minutes.

Export only audio
This section will guide you through exporting just the audio track of your project.
 
Step 1: Click the Export button in the bottom right-hand corner of the Editor to open the export settings window.

 
Step 2: At the top of the Export window you will find a number of tabs. Click on the Save Only Audio tab.

Step 3: Open the list at the top of the tab and select the format you'd like to save the audio in.



 

 

While MP3 is the most commonplace format, supported by almost all media players and devices, FLAC format allows you to preserve high
audio quality, albeit taking up considerably more disc space. When choosing an output format, it is important to note the quality of the
original files: due to data compression limitations, digital audio cannot be restructured from very low quality files by saving them as FLAC
audio, and vice versa – high quality files may lose some of that quality when saved to MP3 format which is limited to 320 Kbps.
 
When saving audio from your project, the audio file will retain the same sample rate and channel settings as you have set for your project.
The audio bitrate will be determined from the quality of the original files and from the maximum bitrate for the selected format (for example,
MP3 is limited to 320 Kbps, while FLAC bitrate is not limited).
 
Step 4: Name your file and choose a destination folder.
In the 'Save to' field, enter the folder where you would like to store the file. By default, this will be the directory for saving output videos
specified in the preferences. To set a different folder, click the Browse button and choose the folder in the Windows Explorer window, or
enter the path manually into the box. Name your video in the File Name field: the project's name will be filled in for you by default.

Step 5: Click the Start button to begin processing the video file. This may take up to a few minutes. 

Uploading videos online
After you finish your video, you can share it to YouTube right from the export window.
 
Step 1: Open the Export window
1. Click the Export button to open the exporting window.
2. Switch to the Upload online tab.

Step 2: Sign in to your account
1. Click Sign in. The authentication page will open in your browser.
2. Sign in to your account and click Allow to let Movavi 360 Video Editor upload videos.



 

 

Step 3: Choose a resolution
In the Export window, open the Resolution list and choose a resolution that suits your project.
•  For best results, choose a resolution that is equal to or less than the height of your project. You can find the resolution of the project at the
bottom of the main window, next to Project settings. For example, if your project is 1280x720, choose the 720p resolution.
•  This resolution will be the highest available quality available for your video. Lower resolutions will be generated automatically by the
website.

Step 4: Fill in the details
1. Fill in the title and description for your video.
2. Add some tags to help users find videos by relevant topics. Separate tags with commas and add a number sign (←) before each one.
3. Choose a category to help viewers find relevant content.
4. Open the Privacy box and choose who you want to see the video:
•  Private – only you can see the video.
•  Unlisted – the video will not appear for other people unless you give them the link.
•  Public – anyone can access the video.

Step 5: Save and upload the video
1. Before uploading, the video will be saved as a file on your computer. To change where the video file is stored, click Browse and select a
folder.
2. Check the length and size of the video. YouTube allows users to upload videos up to 15 minutes. To upload longer videos, you need to
verify your account.
YouTube help – increasing your upload limit 
3. Click Start to begin saving and uploading the video.

https://support.google.com/youtube/answer/71673?hl=en


 

 

Project settings
Project settings affect your entire project and define how different kinds of videos, photos, and audio files are composed into your finished
video. You can set up your project's video and audio settings when creating the project or at any other time.
 
Opening project settings
•  On the bottom panel of Movavi 360 Video Editor, find the pencil icon next to the information about your project. 
•  Open the Edit menu and choose Project Settings.
The Project Settings window will open.

Video settings
The video settings apply to all videos and photos used in the project. When you import the media files, they will be scaled to fit inside the
selected frame size according to your settings. 
 
Resolution
The frame size or resolution determines the videos width and height in pixels. Videos in 360° format usually have a very large resolution
to cover the entire field of view and make the video more realistic. New projects are created with the standard resolution of 2160x1080
pixels. To change it, open the Resolution list and choose an option that matches your video files, or manually enter the width and height into
the boxes below. Choose your resolution based on the original videos: using a lower resolution will cause the video to lose quality, and a
resolution higher than the original will only cause an increase in file size and not quality.
 
Frame rate (FPS)
The frame rate determines how many frames appear in each second of the video. A higher frame rate makes the video appear smoother, and
is even more important for immersive 360° videos. However, the frame rate is limited by the original frame rate of the videos and cannot be
increased.

 
Audio settings
Sample rate
The sample rate affects the quality of digital sound, and defines the maximum frequencies that an audio stream can contain. The default
sample rate is set to 44100 Hz, which exceeds the maximum frequencies of human hearing and is used to record Audio CDs and most music
tracks.
 
Channels
Stereo sound contains two channels and has the capacity to convey the relative location of sound sources, which makes it best for recording
music; mono sound has only one channel and produces sound without differentiating left and right channels. Stereo is the generally
preferred number of channels, however, some mobile devices record sound only in mono mode. Surround sound (5.1) allows for even better
sound localization than stereo, but requires a special setup with five speakers and a subwoofer.
 

Program preferences
 

To open the preferences:
1. Click the Settings menu
2. Select Preferences.



 

 

 
The Preferences window will open. The preferences are organized into tabs. Click on a tab to open the relevant options.

When you're done, click OK to close the window and apply the preferences.

See also:
General preferences
File preferences
Sharing preferences

General preferences
Interface Language – to change the interface language, simply select the necessary language from the list and click OK to apply the
changes.
 
Automatically check for updates – select this option and you'll be notified whenever a new version is available. Updates within your version
are absolutely free (e.g. 1.0 to 1.1), while new releases are offered with a hefty discount to registered users.
 
Send anonymous usage stats to Movavi – checking this box will allow the program to send usage statistics to our development team,
enabling us to fix any bugs you may encounter much faster, as well as add new features that you might be missing. The data contains no
personal information, will not be disclosed to third parties and will be used for software improvement purposes only.
Learn more about how we use the statistics
Read our Privacy Policy
 
Use software OpenGL implementation – this option can be useful if your computer doesn't support the necessary OpenGL version and you
see an error message when you start the program.
 
OpenGL is a software interface that manages graphics output. Usually, OpenGL is handled by your graphics card driver. However, some
graphics cards do not support the necessary version of OpenGL. For these graphics cards, you can use this option to download and install a
software replacement. Installation will run automatically, but you will need an Internet connection to download the files.
 
If Movavi 360 Video Editor runs without showing an OpenGL error message, this option is not recommended.
Learn more about OpenGL troubleshooting
 
Play notification sound when exporting is finished – when saving a project as a media file, you'll be notified as soon as the process is
completed.

http://www.movavi.com/mip.html
http://www.movavi.com/privacy.html


 

 

File preferences
On the Files tab, you can find the options for storing and saving different kinds of files. You can change any of these folders to a different
location.

 
Save project files to – this folder will by offered by default when saving and opening projects. This folder will also store any autosave files
for new projects. You can use the autosave file to restore your work in case of an error or force close.
 
Save output videos to – this folder will be offered by default when exporting media files.
 
Store audio recordings in – the audio clips that you record in the Editor will be stored as audio files in this folder. Tip: if you delete these
audio files, the audio recordings in the project will also be unavailable.

Changing where the files are stored
Using a different folder might help if you don't have much disk space on your primary drive, or if you want to organize your media files in
another way.

1. Click the button with three dots  next to the folder you want to change.
 
2. A Windows Explorer dialog box will open. Choose the folder you want to save the files to.
 
3. Click Select Folder to use this folder. 

Sharing preferences
On the Sharing tab of the Preferences window, you can manage your social network accounts for uploading videos.
 
To sign in:
1. Click Sign In. The authentication page will open in the browser.



 

 

2. Sign in to your account.
3. On the next page, allow Movavi 360 Video Editor to upload videos to your account.

4. Return to Movavi 360 Video Editor. Your name will be shown in the Preferences window.
 
To sign out or use a different account:
Click Sign Out. After this, you will need to sign in again to upload videos.



 

 

Help and support
Didn't find what you were looking for? Need help with a problem? Have a suggestion? Contact our support team and we'll help you right away.

How to reach us
By e-mail: support@movavi.com
Fill out a support form
We guarantee a response within 3 business days!
 
If you ran into a problem, please describe it in as much detail as possible; any screenshots, log files, or information
about your system will allow us to help you faster.

 
Frequently Asked Questions
Why can't I add my 360° files?
For some cameras, you need to use the software that came with your camera to convert the video before it can be viewed or edited in other
applications. If you aren't sure how to do this, please check your camera's user manual.
 
Why is the resolution so low?
To create an immersive 360° video, the video frame must be stretched to 360 degrees around the viewer. To create this effect, the video
resolution must be very large. Even if your camera shoots video in 4K, a resolution that would be very sharp and clear on a normal screen,
the video quality will appear much lower once it is stretched to 360 degrees. Try increasing the resolution in project settings if your original
videos have a resolution above 2160x1080 pixels.
 
Titles or overlays disappeared after adding
When you edit titles, callouts, and overlays, you see them in equirectangular mode, meaning that the entire scene of your 360° video is made
to fit into the player so that you could easily position the objects in the video. When you finish editing, the player switches back to 360° mode,
where you see only a part of the video, like you would in a player. Click and drag your mouse inside the player to move around the scene until
you find the objects you've added.
 
The program is slow
Most 360° cameras shoot video in a very high resolution to create the spherical effect. High resolutions require more processing power than
normal video, especially over 4K. Try closing other software that you aren't using.
 
A watermark appears on my video
All videos saved in the trial version have a watermark on them. To remove it, buy an activation key and enter it into the program, then save
the video again without the watermark.
How to remove trial restrictions
 

System requirements
Note that Movavi 360 Video Editor may also run on slower machines, however, we cannot guarantee stable performance if the minimum
requirements are not met.
 
  Minimum system requirements Recommended configuration
Operating system Windows 7/8/10 with latest service packs and patches
Processor Intel, AMD or compatible processor, 1.5

GHz
Intel, AMD or compatible processor, 2.8 GHz
and above

NVIDIA® GeForce® series 8, Intel® HD Graphics 2000, AMD Radeon™ R600 or higher, with
up-to-date drivers
 

Graphics card

Your graphics card must support OpenGL
2.0 and above for the program to work
correctly.

OpenGL 2.1 and above is recommended for
smooth performance

Resolution 1280x768, 32-bit color 1920x1080 or higher
RAM Windows XP, Vista – 4 GB

Windows 7, 8, 10 – 8 GB
Windows XP, Vsta, 7,8, 10 – 8 GB

Available disk space 280 MB for installation
500 MB for ongoing operations

A solid-state disk (SSD) or a high-speed multi-
disk RAID is recommended for 360 media. 360
video processing may require larger amounts
of free disk space.

  Administrator permissions are required for installation
Additional features   Sound card for audio recording and playback
 

Supported formats
Here you can view the list of formats and codecs supported by Movavi 360 Video Editor.
 

 Input formats

Video 3GPP, 3GP2, ASF, AVI, DIVX, FLV, SWF, M2TS, MKV, MOV, MXF, MP4, MPG, OGV, QT, RM, RMVB, WEBM, WMV, WTV
Audio AAC, AIFF, APE, AU, FLAC, MP3, M4A, M4B, OGG, WAV, WMA, AMR
Images BMP, DPX, GIF, JPEG, JP2, JLS, PGM, PBM, PPM, PAM, PCX, PNG, PTX, TGA, XBM, XWD

 Output formats

Video MP4, MKV * These formats are able to support important metadata for 360 degree video.

mailto:support@movavi.com
https://www.movavi.com/support/contact.html


 

 

Audio MP3, WAV, AAC, FLAC, OGG, WMA
 

Codec activation
Some video and audio codecs are patented by other companies, and it is required that new users activate the codecs they use to comply
with patent law.
 
Activate codecs on demand
1. When you open a media file or export your project with one of these codecs, you may see a Codec Activation message.
 
2. Select the Activate other codecs without asking box to activate all codecs automatically in the future. The codecs will be activated
automatically, but an Internet connection is still necessary.
 
3. Click Activate to complete the codec activation.

Codec could not be activated
If you see a codec activation error, make sure that you have a working Internet connection. Without Internet, the codecs cannot be activated
even if you've chosen to activate them automatically. After you've restored the network connection, please restart the application.
 
What kind of data is being sent?
The data we send does not contain any information that can personally identify you. We only receive information about which codecs were
used.

OpenGL troubleshooting
If you see the following message about OpenGL when you open Movavi 360 Video Editor or you've noticed that the player, filters, or
transitions do not work, your computer most likely does not support the necessary version of OpenGL. To run Movavi 360 Video Editor, your
computer needs to support at least OpenGL version 2.0, and version 2.1 is required for smooth performance.

OpenGL is a software interface that manages graphics output. Usually, OpenGL is handled by your graphics card driver. However, some
graphics cards do not support the necessary version of OpenGL. For these graphics cards, you can try the steps below:
 
Step 1: Update your graphics card driver
Sometimes, this issue may occur when something is wrong with the graphics card drivers or they are out of date. Download the driver
installation file from the manufacturer's website and install it following the on-screen instructions.
Detailed instructions on updating the driver
 
It is recommended that you restart the computer after installing driver software. After that, try starting Movavi 360 Video Editor. If you see an
error message again, proceed to the next step.
 
Step 2: Try the software OpenGL implementation
If your graphics card still doesn't support OpenGL 2.1 even after updating the driver, you can use a software alternative:
 
•  In the message you see after starting Movavi 360 Video Editor, select the Download and install software OpenGL implementation box.
 
•  Or, in the main Movavi 360 Video Editor window, open the Settings menu and choose Preferences. There, select the Use software OpenGL
implementation option and click OK.



 

 

After that, the software OpenGL package will be automatically downloaded and installed. When the installation is finished, restart Movavi 360
Video Editor.
 
If these steps haven't helped:
•  Check that your computer meets the minimum system requirements. Your graphics card must support at least OpenGL 2.0.
•  Contact our support team. Provide your graphics card model and list the steps you've taken to solve the problem. 

Updating the graphics card driver
If you encounter an error message asking you to update your graphics drivers, you will need to download a new driver from your graphics
card manufacturer's website and install it on your system. Some graphics card drivers also have a useful utility that notifies you when a
driver update is available and updates the driver automatically. Keeping your graphics card drivers up-to-date will ensure stable performance
of applications and games on your computer.
 
Step 1: Find your graphics card manufacturer
1. Right-click your desktop and choose Screen Resolution
2. In the Screen Resolution settings window, click Advanced settings.
3. This will open your graphics card properties. At the top of the window, your graphics card model will be listed under the Adapter Type
section. Note the full name of the graphics card somewhere for later.
 
Step 2: Download the new version
Now that you've learned your graphics card manufacturer and model, go to the manufacturer's website and find driver downloads. There,
look for the model or series that you've found earlier and download the driver installation file. Some manufacturers may also offer a utility
that will automatically find the necessary driver.
NVIDIA download center
AMD download center
Intel download center
 

Warning:
Only download drivers from the official manufacturer's website. Third-

party websites offering driver downloads may contain malware.
 
Step 3: Install driver
Once the file is completely downloaded, run the installation file and follow the on-screen instructions to install the driver on your system.
Your display may blink several times in the process. After the installation has finished, it is advised that you restart the computer.
 

 
Updating NVIDIA® Driver
Modern NVIDIA graphics cards come with a special application called NVIDIA GeForce™ Experience that monitors driver updates and allows
you to optimize your computer's graphics performance.
 
1. Open the NVIDIA GeForce Experience application. It should already be installed on your system. If you cannot find the application, please
try the method above.
NVIDIA download center
 
2. In the Drivers section, click the Check for updates button to find the latest drivers.
 
3. When the application has found a newer driver, click the Download driver button. From here, the software will automatically download and
install the necessary driver for your system.

https://www.movavi.com/support/contact.html
http://www.nvidia.com/Download/index.aspx?lang=en-us
http://support.amd.com/en-us/download
https://downloadcenter.intel.com/
http://www.nvidia.com/Download/index.aspx?lang=en-us


 

 

Updating AMD® or ATI® Driver
1. If you have an AMD or ATI graphics card, go to the Driver Download Center on AMD's official website.
AMD Driver Download Center
 
2. Download the auto detect utility and run it when the download has finished. 
Auto Detect Utility
 
3. The utility will then automatically find your graphics card and help you download and install the right driver for your system.
 
If the utility fails to find a driver for you, you can manually select your graphics card model and operating system on the Driver Downloads
page and download the driver.
 
4. After the driver has downloaded, run the installation file and follow the on-screen instructions to install it.
 
5. After the driver has been installed, it is recommended that you restart your computer.
 

If none of the above steps have helped, feel free to contact our support team via e-mail or live chat.
 
If possible, please include the name of your graphics card model (see Step 1), as well as screenshots of any error messages you have
encountered. This will help our support team specialists solve your problem quicker.
 
 

http://support.amd.com/en-us/download
http://www2.ati.com/drivers/auto/autodetectutility.exe
mailto:support@movavi.com
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